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What is OmniGraphSketcher?

OmniGraphSketcher combines some features of illustration software with 
some features of data plotting software, so that you can create graphs 
really, really quickly.

Ordinarily, if you wanted to sketch out a quick graph and have it look 
passably attractive, you’d need to struggle against a drawing application 
that has no idea what axes or data sets are. Or, you’d have to do battle 
with a spreadsheet or mathematics application that makes drawing 
anything feel like pulling teeth: even if you don’t have specific data to plot, 
you need to make some up in order to illustrate your concept.

OmniGraphSketcher is a quick, straightforward tool for creating graphs, 
whether you have specific data to visualize or you just have a concept to 
explicate. And it doesn’t assume that you have gobs of free time and 
attention to learn how to use it.

For the most part, you should be able to click around and figure out for 
yourself how it works. If you get stuck, or you’re just the sort of person 
who likes to read software documentation (hello!), go ahead and continue 
with this manual.
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Introduction to the Canvas

The Toolbar at the top of the window contains buttons for OmniGraphSketcher’s four 
tools (Modify, Draw, Fill, and Text) and some common commands. You can add, 

remove, or rearrange buttons by choosing Customize Toolbar from the View menu. 
Show and hide the toolbar by clicking the white button in the upper-right corner of the 
window.

The Axes define the visible ranges of your data. There are several ways to customize 
the axes’ numerical ranges, appearance, and position.

The Margins are the area between the edge of your graph and the edge of the canvas. 
If you put the mouse pointer near the inside of the margin, a magenta guide appears; 
you can drag it to adjust the margin. Because the axes lie on that same line, you may 
need to go near the corner of the window to adjust these guides. You can also adjust 
the margins in the Canvas inspector.

The Labels on the two axes, and the Tick Labels delineating values along the axes, 
can also be edited. Double-click a label to edit it. (You can edit a tick label at the edge 
of the graph to quickly adjust axis ranges.) Click a label and then use the Style 
inspector to change its appearance. You can also show or hide these labels with the 
Axes inspector.

As you draw or manipulate objects on the canvas, blue Guides apppear to help you 
arrange and align them. These guides correspond to the axis ticks, so you can adjust 
the ticks to make the guides more coarse or more precise. If you prefer not to have 

your drawing constrained by the guides, you can turn off the Snap to Grid setting in 
the Arrange menu.

The Status Bar at the bottom of the window gives contextual, possibly-interesting 
information.

• If nothing is selected: the precise coordinates of the mouse pointer in the 
graph.

• If nothing is selected and the mouse pointer is outside the canvas: the 
dimensions of the canvas in pixels and in inches (assuming 72 dots per inch).

• If a single point is selected: the point’s coordinates.

• If multiple points are selected: the points’ average coordinates.

• If a two-point line is selected: The linear equation that describes the line.

If you click and drag the lower-right corner of the window to resize it, the canvas scales 
along with it. That is, a document is always exactly as big as its window, so there is no 
need to zoom or scroll. You can adjust the canvas size to particular pixel values with 
the Canvas inspector.
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Drawing Lines and Points with the Draw Tool

• Double-click to create an individual point without any line attached. You can 
group these and connect them with a line later, if you like.

• Click once for each point you want; the points are connected by a line. To 
make the last point, double-click. (With this method, you can hold Shift to 
constrain the angle of your line to 45-degree increments.)

• Drag across the canvas with the mouse button down to draw a line freehand. 
OmniGraphSketcher does its best to create a smooth line that matches the one 
you drew.

The Draw tool is how you sketch data, in the form of points, on the canvas. To get into 
Draw mode, just click the Draw button in the toolbar, or hold down the D key (the “hot 
key” for this tool). Draw mode lasts for as long as you hold down the key. As you use 
OmniGraphSketcher more and more, you’ll probably find that the hot keys are the 
quickest way to switch between tools.

While in Draw mode, you have several ways of making points (and connecting them 
with lines):

If you draw a point on top of an existing line or point, the two objects snap together. So, 
subsequently moving one of the objects will bring the other one along for the ride, 
unless you detach them.

The lines and points you draw with the Draw tool follow the default styles defined by 
the Style inspector. To draw differently-styled objects, first deselect all objects on the 
canvas and then adjust the Style inspector to your liking. Any further objects you draw 
will match the new style settings.

Once you’ve created a line or a point, you can change it with the Modify tool.
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Drawing Fills with the Fill Tool

The Fill tool is how you shade or highlight areas of the canvas. To get into Fill mode, just 
click the Fill button in the toolbar, or hold down the F key (the “hot key” for this tool). Fill 
mode lasts for as long as you hold down the key. As you use OmniGraphSketcher more 
and more, you!ll probably find that the hot keys are the quickest way to switch between 
tools.

To create a fill:

• While in Fill mode, click once to define each corner of the fill. You need at 
least three corners, of course, but beyond that you can create as many as you 
need.

If you draw a corner on top of an existing line or point, the corner and the object snap 
together. So, subsequently moving the line or point will bring the corner along for the 
ride, unless you detach them.

If two consecutive corners of a fill are snapped to the same line, the fill conforms to the 
shape of the line.

Once you!ve created a fill, you can change it with the Modify tool.

Adding Labels with the Text Tool

The Text tool is how you add labels to the canvas. Text labels can be attached to pretty 
much anything. There are two ways to create text labels:

• Click the Text tool, then click an object or a blank area of the canvas.

A new label starts out in text editing mode, so you can type or paste text into it. Click 
the Font button in the Style inspector to change the style of the selected text. To go 
back and edit a label’s text later, just double-click it again.

• Double-click an object or a blank area of the canvas.
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Using the Modify Tool

The Modify tool works just like the ordinary mouse pointer in most applications:

• Click an object to select it. You can select individual points, or a whole line or 
fill including all of its points.

Once an object is selected, you can use the Style inspector to change its appearance.

• Hold the Command key while clicking an object to add it to or remove it from 
the selection.

• Hold the Shift key while clicking an object to select all objects between it and 
the last object you selected.

• Drag an object to move it. Hold Shift while dragging to constrain the 
movement to 

• Hold the Option key while dragging an object to duplicate it.

Attaching and Detaching Objects

If you draw a point on top of an existing line or point, or drag a point onto another 
object, the two objects snap together. So, subsequently moving one of the objects will 
bring the other one along for the ride, unless you detach them.

To detach objects that share a point:

1. Select one of the objects. (To be precise about which connection to detach, 
select the particular point that the objects share.)

2. Click the Detach toolbar button, or choose Detach from the Arrange menu.

3. If you selected a whole object, all attachments that the object had are 
broken. If you selected an individual point, just the connection at that point is 
broken.

Note that dragging an entire line or fill into contact with another won’t attach them; you 
need to be dragging an individual point.

To detach a point that is snapped along a line, just drag the point away.
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Locking and Unlocking Objects

If you’ve got something in just the right position, you can keep it from getting 
accidentally moved.

To lock objects:

1. Select all of the objects you want to lock.

2. Click the Lock button in the toolbar, or choose Lock Positions from the 
Arrange menu.

Now the objects can’t be moved until you unlock them.

To unlock objects:

1. Select all of the objects you want to unlock.

2. If all of the selected objects are locked, the Lock button in the toolbar 
changes to Unlock, and the Lock Positions command in the Arrange menu 
becomes Unlock Positions. If some of the objects are locked and some aren’t, 
lock them all first and then use the same command again to unlock them all.

Now the objects can be moved again.
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Grouping and Ungrouping Objects

Related objects can be grouped together, so that they always become selected and 
move as a whole. When you select one object in a group, all of the other objects in the 
group are selected. When you move one member, the rest come with.

To group objects together:

1. Select all of the objects you want to group.

2. Click the Group button in the toolbar, or choose Group from the Arrange 
menu.

Now when you select or move one group member, the other members are 
automatically selected or moved too.

To ungroup objects:

1. Select the group.

2. The click the Ungroup button in the toolbar, or choose Ungroup from the 
Arrange menu.

Now you can select and move the objects independently.

You can cheat a little and still manipulate grouped objects individually without 
ungrouping them, if you really want to. Hold the Command key while selecting a group 
member to avoid selecting the rest of the group.
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Adjusting the Axes

The x-axis and y-axis of your graph determine the range of values that are visible. You 
can adjust their scale to best display your data.

If you already have some data and you want to automatically adjust the axes to it:

• Click the Scale to Fit toolbar button, or choose Scale to Fit Data from the 
View menu.

There are several ways to make an axis show a different range of values:

• Click a tick label (the number) near the end of the axis, and drag it toward the 
edge or toward the middle. The ticks get closer together or father apart. You 
may need to do this more than once to get the range you want.

To move the axes without changing their scale, click and drag either axis.

You can control the location and visibility of axes, tick marks, and labels with the Axes 
inspector.

• Double-click the tick label on the edge of a graph, and type the number you 
want. Note that editing a tick label that’s not on the very edge of the graph just 
changes that label; it doesn’t change the axis range.

• Use the Axes inspector to type in precise axis ranges.

You can change the visual style of an axis with the Style inspector.
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Importing Data

Importing numeric data into OmniGraphSketcher is pretty straightforward. In many 
cases, you can just select it from your spreadsheet, outline, or text document, copy it, 
and then paste it into a graph. If the data is in a text file, it can be comma-separated 
(CSV) or tab-delimited. Here are some tips for amicable importing.

OmniGraphSketcher makes its best guess at the meaning of the data you give it, based 
on these situations:

• Two columns of numbers: Each row becomes a point, with the first number 
as its X value, and the second number as its Y value.

Pitfalls:

OmniGraphSketcher doesn’t (yet) interpret dates. If you paste in data with 
labels that indicate uniform spans of time, like “January 2009, February 2009, 
March 2009…”, they are interpreted as text and applied to the X values 1, 2, 
3…. But if your date labels are not uniformly spaced, OmniGraphSketcher 
doesn’t try to space them out for you. To get around this, you could first 
convert your dates to integers (using, for example, the DATEDIF function in 
Apple Numbers to calculate a number of days).

• More than two columns of numbers: Each row becomes several points, 
with the first number as their X value, and the following numbers for their Y 
values.

• A column of text: If there is only one number column, then the text column 
becomes labels on the x-axis. If there are two number columns, the text 
becomes labels on the points. If there are more than two number columns, the 
text is not used.

• One column of numbers: Each row becomes a point with the imported 
number as its Y value; incrementing integers (1, 2, 3…) are assigned for the X 
values.
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Exporting Data

You can export your graph in a number of image formats, and you can also get your 
numerical data out.

To create an image file of your graph, use the Export command in the File menu and 
choose the format that meets your needs.

• PDF (Portable Document Format) is a lovely vector-based image format that 
crisply preserves the form of your graph at any size, and is the best choice for 
printing or for using with modern Mac applications. It cannot be embedded in a 
web page, though.

If you just want the data points from your graph, you can copy it from the Data 
Points inspector and paste it into a spreadsheet, text editor, or outliner 
application.

• PNG (Portable Network Graphics) is a bitmap (pixel-based) image format that 
will faithfully reproduce your graph, but only at the particular pixel dimensions it 
had on your screen when you created it. This format works well for the Web, as 
it is understood by all decent web browsers.

• JPEG is a bitmap (pixel-based) image format that may introduce some tiny 
visual artifacts into your graph. But, it is more widely supported than PNG or 
PDF, and may come in handy when working with older or less savvy 
applications.

The easiest way to get your graph as an image is to click the Copy As Image toolbar 
button or choose Copy Graph as Image from the Edit menu. Then, you can just paste it 
into another application.
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The Style Inspector

The Style inspector controls all of the visual attributes of objects on the canvas. To 
open it, click the first tab in the inspector. If the inspector isn’t open, choose Style from 
the Inspectors menu.

• Thickness controls how thick a line is, or how big a point is. Drag the slider, or 
enter a precise value in the field. For lines and axes, the value in the field is an 
exact width in pixels. Points with the same Thickness value are considerably 
bigger, so that they are visible even when inside lines.

• Color sets the color of any selected object. Click the color well to use 
the standard Mac color picker. To the right is a slider for quickly making 
the color more transparent or opaque.

The Style inspector affects the objects you have selected on the canvas. If you have 
nothing selected, it instead affects the style of objects that will be created by the Draw 
tool.

• Point Type determines whether to draw points as shapes, as ticks, as bars, or 
not at all. If you choose Shape, you can then specify which shape with the menu 
below. Ticks are short little lines that always draw perpendicular to the line 
they’re on. Bars draw from the point to the x- or y-axis. Choose Hidden to 
prevent the points from appearing at all.

• Line Type sets the way that the selected points are connected. Straight 
Segments connects one point to the next normally. Curved Segments calculates 
a smoothly flowing line between the points. Best-Fit Line uses a linear regression 
equation  to calculate a slope that best describes the selected points.

• Stroke controls the style of line to draw between points. Choose from 
a variety of solid, dotted, dashed, or decorated strokes.

• Shape determines what shape the selected points should have.

• Arrowheads puts a pointy end on the selected line or axis.

• Label Text is an easy way to add or change the label attached to the selected 
object.
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The Style Inspector (Continued)

• Font shows the font particulars for the selected text; click the button to open 
the standard Mac Font panel.

• Font Size offers a quick way to change text size without making a trip 
to the Font panel. Slide the slider, or type an exact value.

• Distance determines how far away a text label should be from the object it is 
attached to. This works for axis and tick labels, too.

• Position is a quick way to check or change the X, Y location of the 
selected object on the canvas.
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The Axes Inspector

The Axes inspector controls the x-axis, the y-axis, and the grid. To open it, click the 
second tab in the inspector. If the inspector isn’t open, choose Axes from the 
Inspectors menu.

You can use the Axis Ranges section as an alternative to modifying the axes directly 
on the canvas, in order to get precise ranges of values. Enter the minimum and 
maximum numbers you want to be visible on each axis. When you change these, the 
objects on the canvas automatically move along with the axes.

The Titles section has buttons for showing or hiding the axes’ titles.

The Tick Marks section has buttons for showing or hiding the little perpendicular lines 
that delineate values on the axes, and their labels.

The Grid buttons show or hide the vertical and horizontal grid lines.

Use the Grid Style section to choose a color and thickness for the grid lines.

The Tick Spacing fields control how frequently ticks should appear along the axes. If 
the ticks are too close together, there may not be enough room for each tick to get a 
label of its own. Tick spacing also controls the spacing of grid lines.

The Axis Positions buttons set where the axes appear, if at all. There is one strip of 
buttons for the x-axis and one for the y-axis; they can have different settings.

• Click the first button to put the x-axis at the bottom or the y-axis at the left of 
the graph, regardless of the axis ranges.

• Click the second button to keep the axis at the origin (0,0), wherever it 
happens to be. If the origin is outside of the graph, then the axis appears at 
the edge closest to it.

• The third button places axes at both edges of the graph. To enclose the 
graph in a box, choose this option for both axes.

• The fourth button hides the axis.
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The Canvas Inspector

The Canvas inspector controls the dimensions and appearance of the drawing area for 
your graph. To open it, click the third tab in the inspector. If the inspector isn’t open, 
choose Canvas from the Inspectors menu.

Click the Color well to open the standard Mac color panel and choose a background 
color for your graph. You can even choose partially transparent colors, if you need to 
export a copy of your graph to overlay on top of something else.

If you must add shadows to your graph, you can do so with the Shadows slider. But 
take heed: information visualization experts frown upon such frippery.

The Canvas Size fields show the dimensions of your window, in points. You 
can just resize the window, of course, but these fields give you precise control 
in case you are aiming for a very particular size. If you need to make a much 
bigger or much smaller final product than your screen will accommodate, you 
can export as PDF and then use a graphics application to scale it.

The Margins section controls the area of the canvas outside your graph. For 
the most part, you can let OmniGraphSketcher automatically set your margins 
for you, based on the size and distance of your axis labels. But if you need 
more space (to add annotations, for instance), you can deselect the 

Automatic checkbox and enter specific values. (You could also drag the 
magenta guides that appear when you put the mouse pointer over one of the 
margins.)
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The Data Points Inspector

The Data Points inspector contains a table of all of the data in your graph. To open it, 
click the fourth tab in the inspector. If the inspector isn’t open, choose Data Points from 
the Inspectors menu.

For the most part, you can use this inspector like a miniature, minimally-featured 
spreadsheet; each row represents a point on the graph. Double-click a cell to add or 
edit a value. Press Tab to move to the next cell. To sort, click the header for the column 
you want to sort by. Anything you enter in the Label column is added as a text label for 
the corresponding point.

What’s especially useful is that you can copy and paste rows between this table and a 
spreadsheet, text editor, or outliner application. See the Importing section for more 
details about sharing data with other applications.

This inspector is also a handy way to select specific points. Any points you 
select in the table are also selected on the canvas.

The Connect Points button is a shortcut for quickly connecting the selected 
points with a line; this is especially useful if you just pasted a bunch of data.

Tips for Working with Data Sets

Sometimes you'll need to bring in data from another application, like a spreadsheet or 
text document. OmniGraphSketcher is pretty good at interpreting your data, so whether 
you're importing one data point, or several sets, the method of transfer is the same.

Simply select and copy the data set or sets you'd like to bring to OmniGraphSketcher 
and then paste it into your graph. OmniGraphSketcher will differentiate between these 
sets and turn each one into a locked group, assigning each group its own style. So 
instead of copy and pasting each set until your fingers will copy and paste no more, 

Best-Fit Lines

Finding the line of best-fit is a snap. Select any number of data points on either your 
graph or in the Data Points inspector. Then, in the Style inspector, choose Best-Fit Line. 
A line will appear, along with a linear regression equation that indicates the slope best 
describing the selected points. (This can be edited like any other label.) You can extend 
or retract the line by dragging its end points.
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Menu Commands

OmniGraphSketcher’s menus are jam-cram-packed with useful commands for working 
on your graphs. Here’s a list of what they all do.

OmniGraphSketcher Menu

About OmniGraphSketcher — A little bit of information about the application. 
Useful for double-checking exactly which version you’re using.

Buy OmniGraphSketcher — This menu item only appears if you haven’t 
licensed OmniGraphSketcher; choose it to visit the Omni Store on the web. 
Buying OmniGraphSketcher keeps our larder full, so we can continue to hand-
craft fine software for you.

Check for Updates — See if there is a new version of OmniGraphSketcher 
available to download. You can also set up automatic checking in the Update 
preferences.

Preferences — Open the OmniGraphSetcher Update preferences. (That’s 
right, there aren’t any other preferences to set!)

Licenses — Open the Licenses window, where you can add 
OmniGraphSketcher licenses you’ve bought, or check your existing licenses.

Services — Access system-wide Mac OS X services offered by other 
applications.

Hide OmniGraphSketcher — Temporarily hide all of OmniGraphSketcher’s 
windows.

Hide Others — Temporarily hide windows of all other applications so you can 
concentrate on OmniGraphSketcher.

Show All — Show all windows of all open applications.

Quit OmniGraphSketcher — Stop using OmniGraphSketcher, at least until its 
siren song lures you back. If you have any unsaved graphs open, you are 
asked to save or abandon them.
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Menu Commands (Continued)

File

New — Start a brand new graph, using your default styles (see Make Current 
Styles Default, below).

Open — Choose an existing OmniGraphSketcher document to work on.

Open Recent — Choose from a list of the last few graphs you opened, for 
convenience.

Close — Close the frontmost OmniGraphSketcher document. If it has unsaved 
changes, you are asked to save or abandon them.

Save — Write the current state of the graph document to the disk.

Save As — Write the current state of the graph document to the disk as a 
different file, leaving the current file as it is. Any further changes that you save 
apply to the new file.

Revert — Cancel any unsaved changes and go back to the last saved version of 
the graph document.

Make Current Styles Default — Save the graph’s axis styles, new line and point 
styles, font styles, and canvas styles to be used for all new graphs you make.

Import — This isn’t a real command! It’s just there to let you know that the best 
way to import data into OmniGraphSketcher is to copy and paste it.

Export — Choose from a submenu of the three types of image you can export 
your graph as.

Page Setup — Use the standard Mac Page Setup panel to configure the paper 
size, scale, and dimensions to use when printing or when exporting the graph 
to PDF.

Print — Use the standard Mac Print panel to render your graph on real 
physical paper, if you are into that kind of thing.
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Menu Commands (Continued)

Edit

Undo — Take back the last change you made to the graph. You can keep 
stepping backward through all of the changes you’ve made since opening the 
document.

Redo — Un-take-back the last change you took back. You can keep stepping 
forward through all of the changes you’ve undone.

Cut — Remove the selected objects from the graph and put them on the 
clipboard so that you can paste them somewhere.

Copy — Put a copy of the selected objects on the clipboard, so you can paste 
them somewhere.

Copy Graph as Image — Put a PDF version of the graph on the clipboard, so 
you can easily paste it into another application. There’s also a handy toolbar 
button for this.

Paste — Put the contents of the clipboard on the graph. You can do some 
clever things with data copied from other applications; see the Importing section 
for details.

Paste as Line — If the clipboard contains rows of data from a spreadsheet or a 
text file that OmniGraphSketcher can understand, save yourself a step and paste 
them as points already connected by a line.

Delete — Expunge the selected objects from existence.

Select All — Quickly select all of the data on the graph: points, lines, fills, and 
ordinary labels, but not the axes, axis labels, or tick labels. Or, select only the 
points, the lines, or the labels.

Select Connected — Select all of the objects that are attached to the 
selected objects. Or, select only the points, lines, or labels that are connected.

Deselect All — Select nothing at all.

Line — Just like in the Style inspector, you can choose to connect the 
selected points with a curved, straight, or best-fit line, or to disconnect them.
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Menu Commands (Continued)

Edit (Continued)

Font — This submenu contains standard commands for changing the 
appearance of the selected text. It works on any text you can select in your 
graph, and is handy for reproducing mathematical contrivances like 
superscripts and subscripts.

Spelling — This submenu contains the standard Spelling commands for the 
Mac OS X spell checking system: Spelling (which opens the Spelling window), 
Check Spelling (which checks spelling in the document once), and Check 
Spelling As You Type (which turns the automatic spell checking on or off).

Special Characters — Open the Mac OS X Character Palette, where you can 

find characters not easily accessible from the keyboard, like ! and !.
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Menu Commands (Continued)

Scale to Fit Data — Adjust the axis ranges so that the graph’s data points fit 
snugly with the size of the window. Also available as a toolbar button.

Swap Axes — Switch the x and y values of all of your data points, and switch 
the axis labels.

Cut — Remove the selected objects from the graph and put them on the 
clipboard so that you can paste them somewhere.

Show Grid — Make the grid visible or invisible. You can customize the 
appearance of the grid with the Axes inspector. Also available as a toolbar 
button.

Show/Hide Toolbar — Make the toolbar visible or invisible.

Customize Toolbar — Open the standard panel for changing the contents and 
appearance of the toolbar that appears on all graph windows. Several useful 
menu commands are available as buttons that you can add to your own toolbar.

Snap to Grid — Turn on or turn off the blue guides that OmniGraphSketcher 
offers to keep your drawing neat and aligned.

Group/Ungroup — Collect the selected objects as a group, or disband the 
selected group. Also available as a toolbar button.

Lock/Unlock Position — Lock the selected objects to stop them from being 
moved, or allow locked objects to be moved again. Also available as a toolbar 
button.

Detach — For any selected objects that are attached to another object, stop 
sharing the attached points and allow the objects to move independently.

View

Arrange
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Menu Commands (Continued)

Window

Minimize — Shrink the frontmost window down into the Dock.

Select Tool — Switch to a particular tool; these commands are provided mainly 
for the convenience assigning them custom keyboard shortcuts in System 
Preferences.

Bring All to Front — Get all of the OmniGraphSketcher windows up in front of 
other applications’ windows.

At the bottom of the Window menu is a list of all of your OmniGraphSketcher 
document windows; choose one to bring it to the front.

Inspectors

Show/Hide Inspectors — Summon up the inspector window, or put it away.

Reset Inspector Locations — This is just in case your inspector window 
somehow ends up in a weird offscreen location and you need to get it back.

Style, Axes, Canvas, Data Points — Switch to the corresponding section of 
the inspector window.
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Licensing

To buy a license:

Click the Buy Licenses button and you will find yourself magically transported 
to the Omni Group’s store on the web. Naturally, this only works when you have 
a live Internet connection.

If you’re considering buying a Family Pack license, note that a Family Pack 
licenses up to five members of a private household. If you’re buying for a 
company or some other organization that’s not a private household, you can’t 
use a Family Pack. Also, if you’re just planning on using OmniGraphSketcher on 
a couple of different computers by yourself, and you don’t intend to have more 
than one copy running at a time, you can just buy a single license.

To add a license you’ve bought:

Click the Add License button.

Use the drop-down menu to select the type of license you would like to use. 
(Keep reading to learn about license types.)

Click the Save button.

Choose Licenses from the OmniGraphSketcher menu to see the Licenses dialog. 
From here you can review and edit your OmniGraphSketcher licenses, which verify that 
you’ve actually paid for the software. (Thanks!)

If you have a license key in an e-mail message, copy and paste both the Owner 

name and the License Key into the appropriate fields. If you can’t copy and 
paste the information, you’ll have to type it in; make sure you copy everything 
exactly as it appears in your license message. Also, double-check that the 
license you’re entering really is a license for OmniGraphSketcher; licenses for 
other Omni Group products won’t work.
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Licensing  (Continued)

To remove a license:

Select the license you want to remove.

Click the Delete License button.

OmniGraphSketcher has three different types of licenses:

Personal: One person, any number of computers. This license is for your 
personal use, and is only available when you are logged in as the user who 
installed the license, on the computer where it was installed. You can install this 
kind of license on more than one computer, but only for your personal use. If a 
personal license is available, the application will use it instead of other types of 
license.

Computer: One computer, any number of people. You can use this license 
on the computer where it was installed, and so can any other user of that 
computer. But, you should not install this license on more than one computer. 
If both a network license and a computer license are available, the application 
will prefer the computer license.

Network: A certain number of people, shared on a network of computers. 
This license sits on your network and is available to any user on the network. 
However, only a certain number of users (indicated by the number of “seats”) 
can use the license at one time. OmniGraphSketcher will only use a network 
license if neither a personal nor a computer license is available.
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Software Update Preferences

OmniGraphSketcher can automatically use your internet connection to check for new 
and updated versions of itself; you can get to the automatic update options by 

choosing Preferences from the OmniGraphSketcher menu.

If Check for Updates is selected, you will be notified when there is a new version of 

OmniGraphSketcher ready for you to enjoy. Click Check for Updates Now to look for 
the newest version once right away.

You can select Include system information to volunteer some information about your 
computer’s configuration when you check for updates. For details about what kind of 

information we collect and how we use it, click the Learn More button. Visit http://
update.omnigroup.com/ to see the statistics we have collected from users.
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Getting Help

OmniGraphSketcher Web Site

Visit the OmniGraphSketcher Web Site to watch tutorial videos and find out the latest 
news.

http://www.omnigroup.com/applications/omnigraphsketcher/

Forums

Head over to the Omni Group forums and get in touch our staff and other users. Share 
your questions, ideas, and experiences of OmniGraphSketcher or any of our other 
applications.

http://forums.omnigroup.com/

Support

If you happen to find yourself stuck, have a really great idea to share, or just want to 
say "Hi!", don't hesitate to send us an email. Support is a pretty big deal for us and we 
like to get to know our users, so it shouldn't be too long before you hear from a human. 
(A robot may let you know we've received it.) To drop us a line, write us at 

omnigraphsketcher@omnigroup.com or select Send Feedback from the Help menu.
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